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What's new in SpeedGrade CC October 2013 release (version 7.1)

To the top

To the top

To the top

To the top

This document describes the new and changed features in the SpeedGrade CC October 2013 release (version 7.1).

For information on what's new in the earlier Creative Cloud updates of SpeedGrade, see What's New in SpeedGrade CC June 2013 release
(version 7.0).

Video: New features overview by Patrick Palmer
Direct-Link workflow between Premiere Pro and SpeedGrade
Support for new camera formats
Multiple masks within a single look
Share a mask across multiple layers
New SpeedLooks for consistent color grading

Direct-Link workflow between Premiere Pro and SpeedGrade

The new Direct Link provides a tighter and more efficient workflow between Premiere Pro and SpeedGrade.

Using Direct Link, you can send or open a Premiere Pro project directly in SpeedGrade, apply color grading, and send it back to Premiere Pro.
The Direct-Link workflow eliminates the need to export and import projects, deal with interchange formats, or any kind of file conversions.

For more details, see Direct-Link workflow between Premiere Pro and SpeedGrade.

Support for new camera formats

When you use SpeedGrade in the Direct-Link mode, the file formats supported in Premiere Pro are automatically supported in SpeedGrade, too.

SpeedGrade now supports the following new camera formats in Direct-Link mode.

Apple ProRes 64-bit
Blackmagic Cinema DNG
Native MJPEGs (1DC)
RED DRAGON with ROCKET-X
Panasonic AVC Ultra Long GOP (Group of Pictures)
Phantom Cine
Sony RAW (F65, F55, F5, FS700)
Sony XAVC Long GOP

Multiple masks within a single look

Earlier, you could not create more than one mask for the same Look or Grade in SpeedGrade. To apply more than one mask, you had to create a
new Look or grading clip on a new grading track.

SpeedGrade now lets you create multiple masks within a single grading layer using a single .look file. It is as simple as adding a new layer, and
using the Mask tools to create a mask for that layer.

Using multiple masks in a single Look (or grade) allows you to work faster and keep your Timeline better organized.
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Share a mask across multiple layers

You can share a mask across multiple layers by using the Link Or Unlink Current Layer button.

You can link a layer with the layers immediately below by clicking the Link Current Layer button. When you apply a mask to the main layer, the
mask is applied across all the linked layers.

Use the Link Or Unlink Current Layer button to toggle between linking or unlinking a mask.

Toggle button to link or unlink mask

New SpeedLooks for consistent color grading

SpeedGrade now includes a SpeedLooks package that provides you out-of-the-box Looks to add vibrance and consistency to your grading.

The SpeedLooks package includes Camera Patches and SpeedLooks. The Camera Patches are designed to adjust color spaces quickly when
working with different cameras on the same project.

When you add a SpeedLook to footage that has Camera Patches applied, you get a consistent grading result across footage shot on different
cameras.  

SpeedLooks and Camera Patches are available as presets in the Look panel.

For more information on SpeedLooks, see New SpeedLooks and camera patches in SpeedGrade CC.
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What's New in SpeedGrade CC June 2013 release (version 7.0)

To the top

SpeedGrade CC October 2013 release (version 7.1) is now available. For information about the new and changed features in this release, see
this What's New article.

Adobe® SpeedGrade® CC offers several new features and enhancements that enrich your color grading experience for digital video. Read on for
a quick introduction to new features with links to resources offering more information.

SpeedGrade new features overview
Redesigned, customizable user interface
Look Management Browser
Snapshot View and Snapshot Browser
Continuity Checker and Automatic Shot Matcher
New Luma Waveform and Analysis Tools panel
Support for Tangent Element
Other changes
New and changed default keyboard shortcuts

Redesigned, customizable user interface

SpeedGrade has several user interface enhancements to help you color grade your footage quickly and more intuitively than before.

The first thing you’ll see when you launch SpeedGrade is the redesigned user interface. The user interface provides a more familiar screen layout
for Adobe Premiere Pro users. The important tools and controls that you need are available for immediate access, helping you quickly accomplish
your grading tasks.

The use interface contains a main toolbar and tabs on the upper right of the screen. The tabs are in the sequence of the SpeedGrade workflow:
locating your media, grading, rendering, and reviewing the final output.

For more information, see SpeedGrade workspace.
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Look Management View Mode

Quick View Mode

Minimized Browser View

Redesigned user interface

Look Management Browser

The Look tab now has a Look Management Browser to effectively organize, view, or minimize the Look presets (.look files) that you save.

The Look Management Browser provides the following three different views to display Look presets.

Displays the Look presets as thumbnails in multiple rows. You can view several .look files at once. You also have
a tree-view navigation structure to set the default Looks folder.

Look Management View mode

Displays Look presets as thumbnails in a single row

Quick View mode

Displays the Look Management Browser in a tabbed-browser view without displaying any thumbnails. This view gives
the Monitor panel more screen space for your grading work.
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Snapshot View and Snapshot Browser

SpeedGrade provides you a Snapshot view that lets you quickly capture and save a snapshot of your footage. You can capture still images of your
grades to use as a scene reference, or to guide grading on other shots. You can view the images using the Snapshot browser.

For more information, see Snapshot View and Snapshot Browser.

Snapshot Browser

You can also import images from other applications, such as Adobe Photoshop, and view the image inside SpeedGrade using the Snapshot view.
You can then use the image as a reference to grade your footage. 

For more information, see Matching a Photoshop grade.

Continuity Checker and Automatic Shot Matcher

SpeedGrade now lets you quickly compare multiple shots on the timeline using the Continuity Checker, and match the color grading as required.

The new Shot Matcher feature in SpeedGrade automates the process of matching color between different clips.

The Continuity Checker is often used in combination with the Shot Matcher feature.

For more information on using these features, see Continuity Checker and Shot Matcher.

Review sequential clips with Continuity Checker to ensure grading consistency
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New Luma Waveform and Analysis Tools panel

SpeedGrade provides various tools, like the following, to analyze your image:

Histogram
Vectorscope
RGB Parade
Luma Waveform

The new Luma Waveform scope displays a representation of the luminance of your images, helping you achieve precise black-and-white
balancing.

All the image analysis tools are now grouped together and available from a separate Analysis Tools panel.

To display the Analysis Tools panel, use the keyboard shortcut W, or click the arrow on the upper-left Monitor panel. You can adjust the size of
the Analysis Tools panel using the drag handles.

For more information, see Image analysis tools.

Use different analysis tools for accurate image analysis

Flexible layout display and color precision options

You can view the analysis tools in a flexible layout display by using the Scopes Layout pop-up menu.

You can view one or more (up to four) active scopes simultaneously. Right-click (Win) or Ctrl+click (Mac) to switch to a single scope or multi-scope
display.

Layout options

You can specify color precision of 8-bits, 10-bits, 16-bits, or a special color bit depth called float.
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Note:
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Color precision options

Support for Tangent Element

Apart from supporting hardware devices like the Tangent CP 200 panels and Tangent Wave, SpeedGrade now also supports Tangent Element.

Other changes

Mercury Transmit support for third-party video hardware

Mercury Transmit integration in SpeedGrade lets you use a second display for reference monitoring by using supported video I/O cards from AJA
and Matrox. 

To use the devices with SpeedGrade, In the Preferences dialog box, select Display to view and enable the compatible devices.

To run the third-party devices with SpeedGrade, you need to separately install the hardware drivers and firmware, as required.

Support for nVidia SDI

SpeedGrade continues to support nVidia's Quadro SDI Output cards, enabling efficient SDI monitoring of the graphics-to-video output workflow.

New and changed default keyboard shortcuts

For a complete list of keyboard shortcuts, see Keyboard shortcuts in SpeedGrade CC.

Keyframe shortcuts

Result Windows/Mac OS

Add a keyframe F2

Remove a keyframe Shift+F2

Go to the previous keyframe F3

Go to the next keyframe F4
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Look Browser and Snapshots Browser shortcuts

Other new or changed shortcuts

Removed shortcuts

Result Windows Mac OS

Navigate Look Browser Alt+Arrow Alt+Arrow

Toggle Looks Management Browser
on/off

Ctrl+L Command+L

Navigate Snapshot Browser Shift+Alt+Arrow Shift+Alt+Arrow

Capture/toggle snapshot Shift+C Shift+C

Collapse the third panel in the
Snapshots browser

W W

Auto Shot Match Ctrl+M Command+M

Result Windows Mac OS

Add one or more playheads while
using the Continuity Checker

Alt+1/2/3 Option+1/2/3

Open Analysis Tools panel A A

Escape fullscreen view Esc or Shift+H Esc or Shift+H

Toggle grading on/off 0 (zero) 0 (zero)

Toggle mouse between main and SDI
display

Shift+X Shift+X

Result Windows Mac OS

Toggle alpha channel A A

Toggle Automirror Ctrl+M Cmd+M
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Getting Started tutorials

What is SpeedGrade
Adobe TV (Jun. 17, 2013)
video-tutorial

Overview of Adobe SpeedGrade CC
Adobe TV (Jun. 17, 2013)
video-tutorial

Learn SpeedGrade CC video tutorials
Adobe TV (Jun. 17, 2013)
video-tutorial

Creative Cloud for Video
video-tutorial (Jun. 17, 2013)

Learn SpreedGrade video tutorials
Adobe TV (Jan. 16, 2013)
video-tutorial
Learn how to do the basics of SpeedGrade with Getting Started and New Features tutorials by product experts.

SpeedGrade FAQ
troubleshooting (May. 14, 2012)

What is SpeedGrade?
Video2Brain (May. 7, 2012)
video-tutorial
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Basic workflow

To the top

Load footage
Apply color grading
Render out content
Special tools and workflows
Related topics

The SpeedGrade workflow consists of three main steps: load footage, color grade, and render out finished content.

Use the following tabs to perform the workflow:

Click the Media tab to access the Media Browser for loading footage
Click the Color tab to access the Monitor view for applying color grading
Click the Render tab to access the Output view for rendering out the completed project

All the tabs are available from the SpeedGrade main user interface. For more information, see Redesigned, customizable user interface.

Load footage

1. Locate content using the Media Browser. Use the folder browser on the left side to navigate to the folder containing your content.
Thumbnails of the clips appear in the Media Browser.

If you have many clips, you can manage them as follows:

Sort alphabetically.
Sort by time code range, resolution, or date modified.
Filter to display only certain file types.
Search for specific filenames or filename extensions.

Media Browser

2. Add clips to the Timeline by double-clicking or dragging them to the Timeline.

Drag clips by their handles to reposition them on the Timeline.
Set in- and out-points and switch between Timeline views as you review or color grade your content
You can add up to nine separate playheads. See Compare frames with multiple playheads.
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3. If you want, load Edit Decision Lists (EDLs) on the Timeline. See Color grade a sequence.

To add an EDL, double-click the EDL in the Desktop view.
To add the clips to the EDL, choose Reels in the Timeline panel and click Load from Desktop.

Apply color grading

1. Apply color correction to balance blacks and whites and to match shots. See Color grade a clip.

Apply primary color adjustments to the whole image, the shadows, the midtones, or the highlights.
Select color ranges to apply secondary color adjustments.
Use the waveform, histogram, and vectorscope to ensure accurate color adjustments, such as balancing blacks and highlights. 

2. Use effects, film-style filters, and masks to design creative looks.

Add new grading layers to build your look.
Apply masks to individual layers, for example to create a vignette.
Add unlimited layers and reorder as required. Changes are applied non-destructively.
Each layer has its own opacity slider where its influence on the overall look can be adjusted.

3. Match the color grading between two video shots using the Continuity Checker and Automatic Shotmatch features.

Quickly correct underexposed or overexposed footage by using another shot as reference.
Match the grading of an external image. For example, apply a color grade that you create in Adobe Photoshop to your video clip.

For more information on these features, see Continuity Checker and Automatic Shotmatch.

4. Animate masks or grades to match movement and changing light in your frames.
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Add keyframes to your masks or grading tracks.
Adjust masks or grading at keyframe positions.
SpeedGrade animates transitions smoothly between keyframes.

5. Save grades as Look files and apply those looks to footage. To apply a look to footage, select the footage and then click a Look file.

The Look file preserves all the layers and settings of the grade.
Click a Look file to apply it to selected footage on the Timeline.
Edit existing looks in the Look panel.
Export looks as LUTs for use in other applications or devices.

The Looks tab has a Looks Management Browser to effectively organize, view, or minimize the Looks presets that you save.

 
Look Management Browser

6. While working on a project, save your Timeline, including all clips and grading settings, as a SpeedGrade project.

Press Ctrl+S (Windows) or Cmd+S (Macintosh) to bring up the Save Timeline As dialog box.

For help and tutorials, see Color grading.

Render out content

Render out content to create digital dailies for review, proxy media for offline editing, or masters for final delivery.

1. Start with the content you want to render on the Timeline and click the Render tab to display the Output panel.

13



To the top

Color spaces

Automatically match cameras

Pan & Scan

Cropping

Dynamic Quality

Aspect ratio

Burn-in

Format defaults for Alexa and RED

Stereoscopic

Scene Detection

 

2. Proceed from the top to the bottom of the panel to apply settings for your render.

Select a location and create a filename for the rendered content.
Choose output format and whether to include burn-in information. See Display burn-in information on frames.
Choose Online Quality for final masters or Offline Quality for proxies and dailies.

Special tools and workflows

Use Color Space Defaults for different file formats in the Timeline panel.

Automatically calibrate cameras using Macbeth color chart test shots.

Add pan & scan tracks to your clips to reframe content. See Adjust the framing of shots with pan and scan.

Use the Crop tool to resize your frames.

Use Dynamic Quality to accommodate viewing on displays with different resolutions.

Use the Aspect Ratio tool to display anamorphic content in a 1:1 aspect ratio.

Toggle the Burn-in tool to display or hide file information in your frames. See Display burn-in information on frames.

Select Alexa or RED format settings under the Format Default tab in the Timeline panel.

Activate stereo tools by checking the Stereo checkbox in the Timeline Setup panel. See Stereoscopic Workflows in SpeedGrade
(Adobe TV video).

Use Scene Detection to identify scene changes in archived material. See Detect scene changes (Help article) or Using Scene
Change Detection in SpeedGrade (Adobe TV video).
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Consolidate Reels

Save EDL

Annotations

Audio Tracks

To the top

Create copies of the clips used in your project to save active storage space.

Export an EDL from a SpeedGrade project.

Add annotations to your clips, or to individual frames.

Add audio tracks to your footage from the Desktop.

Related topics

Color grade a clip
Color grade a sequence
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Quickstart: Color grade a clip
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To the top

Select a clip
Apply a primary color grade
Apply a secondary color grade
Render a graded clip

To load an EDL and color grade a sequence, see Color grade a sequence.

Select a clip

1. In SpeedGrade, select a folder that contains video clips using the file browser in the upper-left corner of the user interface.

The Desktop window shows thumbnail versions of the content in the selected folder.

To filter the thumbnails by file type, select All Files in the upper-right corner and then select a file type.

2. Place a clip on the Timeline by double-clicking it on the Desktop.

3. Click the Monitor Tab in the upper-left corner to view the image.

The default display size is 100%. To fit the image in the monitor window, click the Zoom to Fit button below the scopes window on the
right side of the interface.

 

Apply a primary color grade

Make basic color changes like temperature, white point, black point, and more, to the entire image. The changes are applied to a primary
grading layer.

Access the grading controls by clicking the Look tab in the lower left, below the timeline.

 

16



To the top

Make global changes

Make global changes to the image with the sliders at the top of the Look panel.

 
Global adjustment sliders

To adjust a global setting, do the following:

1. Right-click the triangle icon on the slider and release the click button.
2. Swipe the mouse left or right to change the value.
3. Right-click the triangle icon again to accept the setting.

Make changes to specific regions

Modify color and luminance values in the image's shadow, midtone, and highlight regions using the color control wheels on the Look panel.

 
Color control wheels

To adjust the luminance, do the following:

Left-click the triangle icon on a wheel and drag the mouse left or right in a straight line. Don't drag the mouse in a circle. The further left or
right you drag, the larger the change.

To adjust the color, do the following:

1. Right-click inside the circle and release the click button.
2. Swipe the mouse in any direction to change the value.
3. Right-click again to accept the setting.

You can use color sliders instead of control wheels. To access the sliders, press Shift+Enter.

 
Color sliders

Use the zero (0) key on the numeric keypad to toggle the grade on and off for a quick before and after view. Make sure the NumLock key on
your keyboard is selected.

Apply a secondary color grade

17



Make targeted adjustments to a specific hue range in the image. The changes are applied to a secondary grading layer.

1. Access the secondary color grading tools by selecting the +S icon in the lower-left corner of the Layers window.

2. Select a hue range as follows:

Select a preset hue option by clicking one of the colored buttons along the top of the Hue selection tool.
Sample a hue range by clicking the eyedropper tool with the + icon and then dragging to select a portion of the image in the Monitor
window.

You may have to resize the lower border of the Desktop window to see the eyedropper tools. To resize the window, use the drag
resize tool located at the bottom center of the Timeline.

3. View the portion of the image targeted by the hue range selection by selecting an option from the Gray-out menu at upper-right corner of
the Look tab.

4. Make adjustments and refinements to the selection using the upper triangles of the sliders. Use the lower triangles of the sliders to adjust
fall-off.

5. Make secondary corrections with the Off-set and Gain control wheels in the center of the Look window.

6. Soften and blend secondary corrections using the Denoise and Blur sliders on the right of the Look window.

7. After making secondary corrections, set Gray-out to None.
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Render a graded clip

1. Click the Output tab in the upper-right corner to open the Metadata Render Engine.

 

2. Click the Desktop menu and select a destination folder.

3. Assign a name to the rendered file in the File Name textbox.

4. In Format & Options, select a output file format for the render.

If a desired preset doesn’t exist, create a new one by clicking Other.

5. Click Online Quality in the Render section.

6. Click Render.
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Workspace
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SpeedGrade workspace
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Enhanced in Premiere Pro CC

The Adobe SpeedGrade workspace provides a more familiar screen layout for Adobe Premiere Pro users. There is a familiar placement of user
interface elements such as the media browser, a redesigned autofit monitor, Look Manager, and integrated grading and mask panes.

The use interface contains a main toolbar and tabs on the upper right of the screen. The tabs are in the sequence of the SpeedGrade workflow:
locating your media, grading, rendering, and reviewing the final output.

 
A. Main Toolbar B. Tabs for each step in the workflow 

Main Toolbar

Icons to open, save, redo, undo are available on the main toolbar in the workspace.

 
Main Toolbar 
A. Open  B. Save C. Undo D. Redo E. Preferences 

Preference settings are available from a pop-up dialog when you select the Preferences icon on the main toolbar.

Media Tab
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To the top

Note:

To the top

Click the Media tab to launch the new Media Browser. The Media Browser, formerly called the Desktop view, is the main interface for browsing
through, locating, and loading your assets. Thumbnails of the files in the Desktop view are displayed in the Media Browser.

You can adjust the size of the thumbnails using the slider, and watch a quick preview of the video clip within the thumbnail.

 
Media Browser

Color Tab

Click the Color tab to view the Monitor panel and the Analysis Tools panel.

The Monitor panel lets you quickly scale, match shots, and color-grade your footage using the intuitive user interface. The Monitor panel
automatically resizes to show the whole image. You can zoom in and out when required.

The Analysis Tool panel groups together the image analysis tools available in SpeedGrade. To view the Analysis Tool panel, click the arrow on
the upper-left corner of the Monitor panel.

 
Monitor panel

Render Tab

Click the Render tab to access the Output view for rendering out the completed project.

The Output view remains unchanged from the CS6 release.

Result Tab

Click the Result tab to open the folder of the last render session.
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Mask and Look panels

The Mask panel is now placed next to the Look panel. WIth the masking and grading tools placed side-by-side, you can now work faster on the
mask workflow.

 
Mask panel next to the Look panel for a faster workflow 
A. Mask tools 
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Desktop basics
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Show or hide the Desktop view
Navigate to a folder
Filter the files in the Desktop view
Refresh the Desktop view

Use the Desktop view to find and load footage. You can navigate to folders with image sequences, movie files, or RAW file formats. Thumbnails of
the files are displayed in the Desktop view.

Show or hide the Desktop view

Press the D key.

Navigate to a folder

To navigate to a folder on your hard disk or network, use the breadcrumb control at the top.

 
Navigate with folder breadcrumbs

You can also browse to a folder with the file browser on the left.

You can adjust the size of thumbnails by dragging the Thumbnail Size slider.

Related links

Filter the files in the Desktop view

If you have many files, you can filter them to display only the files with a specific filename extension or files starting with specific characters.

To show or hide files, enter the filtering criteria in the text box in the upper right. Use the asterisk character (*) as a wildcard character.

For example, to display only files R3D filename extensions, enter *.R3D.

Refresh the Desktop view
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Click the Refresh button. Refreshing the view is useful if you updated files while SpeedGrade was running.
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Timeline basics
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Footage

Grading

Playhead
Tracks
Manage tracks
Play a part of the Timeline
Navigate along the Timeline
Zoom the Timeline
Change the Timeline view
Delete the Timeline

Playhead

The playhead displays a frame in the Monitor at any given position on the Timeline.

Drag the playhead to move it along the Timeline.

Playhead controller

To view more than one frame at a time, create additional playheads. Multiple playheads are useful for comparing different parts of the same shot
or scene. For more information, see Compare frames with multiple playheads.

Tracks

Add tracks to the Timeline to generate layers for grading, add audio to the project, or to adjust the framing with pan and scan.

Multiple tracks

You can add the following tracks to the Timeline:

Blue track. To add footage to the timeline, see Select a clip.

Red track. To add a grading track, see Create a grading track.
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Audio

Pan & scan
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Note:

To the top

Solid green track. To add an audio track, open the Desktop, locate the audio file (wav or aiff file), and drag it on the Timeline. Repeat this
procedure with additional audio files.
To change values for sound output, such as the mixing frequency, select Settings > Sound. The Settings menu is on the upper-right corner of the
SpeedGrade workspace.

Transparent green track. To add a pan & scan track, see Create a pan and scan track.

Manage tracks

You can manage the tracks on the Timeline with the tools on the left side of each track.

 
Drag, lock, and eye icons

To show or hide the track, click the Eye icon.
To lock or unlock the track, click the Lock icon.
To delete the track, click the Drag icon and drag the track off the Timeline.

Play a part of the Timeline

Specify the part of the Timeline to play by repositioning in- and out-points. The two points are located above the tracks, at either end of the clip or
playlist.

 
In-point

In- and out-points in SpeedGrade are not used to edit clips as in Adobe Premiere Pro. They're used to control playback.

Do any of the following to reposition the in- and out-points:

Drag the in- and out-points along the Timeline.
Hold Shift to drag both points together.
Control-click the in- or out-point to reset it to its default position.
Double-click a clip to set the points to the start and end of the clip. Double-click again to set the points to the start and end of the Timeline. 

You can also double-click the in- or out-point icon and specify a frame number for it.

Navigate along the Timeline

If you have multiple clips or tracks on your Timeline, you can navigate from clip to clip or from track to track. Moving from one track to another
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All

In/Out

Selected

Master

Playhead
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changes the selected SpeedGrade panel. For example, moving to a grading track opens the Look panel. Moving to a pan and scan track opens
the Pan & Scan panel.

Related links

Zoom the Timeline

1. Select the Master Timeline view from the view menu on the upper-left side of the Timeline.
2. Press Ctrl+Scrollwheel.

Zooming works only in the Master or Playhead view of the Timeline. See Change the Timeline view.

Change the Timeline view

Set the Timeline view with the menu on the upper-left side of the Timeline.

 
Timeline views

Shows all content and playheads on the Timeline.

Shows all content between the in- and out-points.

Shows all content in the selected track.

Keeps the Timeline centered on the Master playhead. On the Timeline, the playhead controller with the orange number box is the Master
playhead.

Keeps the Timeline centered on the numbered playhead. The number on the playhead controller identifies the playhead.

Delete the Timeline

Click the Delete (X) icon on the right side of the Timeline and confirm that you want to delete the Timeline.

Result Windows Mac OS

Go the next clip Ctrl+Shift+Right Arrow Cmd+Shift+Right Arrow

Go to previous clip Ctrl+Shift+Left Arrow Cmd+Shift+Left Arrow

Go to track above Ctrl+Shift+Up Arrow Cmd+Shift+Up Arrow

Go to track below Ctrl+Shift+Down Arrow Cmd+Shift+Down Arrow
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Playback shortcuts
Playback controls
Playback indicators
Change the base frame rate
Change the playback frame rate
Change the playback mode

Playback shortcuts

Close the Desktop before playback (press D).

Playback controls

 

Playback controls from left to right:

Go to in point
Frame step backwards
Play backwards
Pause
Play forward
Frame step forward
Go to out point

Playback indicators

 

Result Keyboard shortcut

Play forward L

Play backward J

Stop playback K

Play/pause Spacebar

Step forward or backward Right or Left Arrow

Increase or decrease frame rate by 1 fps Page Up or Page Down

Change playback mode F6
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The playback indicators on the left side of the Timeline provide the following information, from left to right:

The current base frame rate
The playback frame rate
The disk performance indicator
The monitor performance indicator

The disk performance indicator turns red when one of the disks or the CPU cannot deliver real-time decoding at the desired playback speed.

The monitor performance indicator turns red when one of the following issues is detected:

An issue with the real-time performance of the grading operations you apply to the clip
A sync issue with your display device.

Change the base frame rate

1. Select Settings > Playback.
2. Enter a new base frame rate.

Note: The Timeline timecode values reflect your base frame rate setting.

Change the playback frame rate

Press the Page Up or Page Down key to increase or decrease the frame rate by 1 frame per second.

Change the playback mode

SpeedGrade has three playback modes:

Single run
Ping pong
Loop (default)

To switch modes, press F6 or use the Playback Mode button next to the playback controls.
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Compare frames with multiple playheads
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Create an additional playhead
Select a master playhead
Adjust the interval between playheads
Delete a playhead
Work in split-screen mode
Keyboard shortcuts

Use multiple playheads to compare two or more frames for color matching.

Create an additional playhead

Hold the Control (Windows) or Command (Macintosh) key down and drag the Move Playhead icon anywhere in the Timeline.

The Move Playhead icon is the arrow icon on the right side of the playhead controller.

 

Make sure a green Plus (+) icon appears on the left side of the playhead controller before dropping the playhead.

Select a master playhead

When working with multiple playheads, select a master playhead to make grading and other adjustments.

Click the playhead number to make it the master playhead.

The playhead number turns orange to indicate it is active.

 

Adjust the interval between playheads

Click the Move Playhead icon and position the playhead anywherei on the Timeline.

Delete a playhead
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Note:

Click the Move Playhead icon and drag the playhead off the Timeline. 

Note: Make sure the playhead is not the master one. If the number on the left of the playhead controller is orange, then it's the master
playhead. Select another master playhead by clicking the playhead's number, and then delete the inactive playhead.

Work in split-screen mode

Arrange the screen layout by clicking the View button in the Timeline tab and dragging the icons in the Screen Layout panel.

 

Up to nine playheads can be viewed at once. When using more than nine playheads, click a number in one of the channels and select a desired
playhead to view.

 

Keyboard shortcuts

The default F key assignments must be disabled on Mac OS systems. In System Preferences, select Keyboard, then the Keyboard
Shortcuts panel. Select Expose & Spaces and deselect the default key assignments.

Result Windows Mac OS

Change the current split-screen mode F9 Cmd+F9

Change the horizontal or vertical
orientation of split-screen mode.

F10 Cmd+F10

Flip the channel position of the split-
screen mode.

F11 Cmd+F11
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Work with projects
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Create your first project
Start a new project
Open a project
Save a project
Work on multiple projects at the same time
Rename a project
Delete a project
Move a project to another computer

A SpeedGrade project is stored in XML file with an ircp filename extension. The file contains information about sequences, assets, and editing
decisions.

The file stores references to the name and location of asset files in your project. If you move, rename, or delete an asset, SpeedGrade prompts
you to locate the missing file the next time you open the project.

Create your first project

1. Add one or more assets to the Timeline.

SpeedGrade automatically creates a project file.

2. To rename the project or save it to another location, press Ctrl+S (Windows) or Cmd+S (Macintosh).

If this is not your first SpeedGrade project, see Start a new project.

Start a new project

1. Delete the Timeline of an existing project.

Deleting the Timeline unloads the current project from SpeedGrade. It does not delete the project itself.

Make sure to save your changes to the current project before unloading it. See Save a project.

2. Press Ctrl+S (Windows) or Cmd+S (Macintosh) to save the new blank project.

Open a project

Press Ctrl+O (Windows) or Cmd+O (Macintosh).

You can also click the Open SpeedGrade Project button on the toolbar on the upper-left corner of the workspace.
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You can also open the Desktop view, navigate to the folder that contains the ircp file that you want to load, and double-click the file
thumbnail.

Save a project

SpeedGrade saves the status of your work every 5 seconds. However, saving the current project from time to time is recommended. Multiple
saves are useful for reverting to a previous version you liked better.

Press Ctrl+S (Windows) or Cmd+S (Macintosh).

You can also click the Save SpeedGrade Project button on the toolbar on the upper-left corner of the workspace.

 

You can also click on the Save IRCP button on the Timeline panel.

 

Work on multiple projects at the same time

1. Press Ctrl+O (Windows) or Cmd+O (Macintosh) and open the first project.
2. Use the Media browser view to navigate to the folder that contains the ircp file of the second project that you want to open at the same time.
3. Click the Plus (+) icon on the file's thumbnail.

SpeedGrade opens the second project on a second Timeline. Opening multiple timelines enables split-screen playback.

 

Rename a project
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1. Use the Desktop view to navigate to the folder that contains the ircp file that you want to remane.
2. Right-click the ircp file, select Rename from the context menu, and rename the file.

Delete a project

1. Use the Desktop view to navigate to the folder that contains the ircp file that you want to delete.
2. Right-click the ircp file and select Delete from the context menu.

Move a project to another computer

To move a project to another computer, move copies of all the project assets as well as the project file (ircp). Make sure that the assets retain
their filenames and folder locations so that SpeedGrade can find and associate them to the project automatically.
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Standard dual-monitor setup
Advanced dual-monitor setup

You can use a dual-monitor setup to work with SpeedGrade. The SpeedGrade workspace is displayed on one monitor and the footage is
displayed on the other.

Standard dual-monitor setup

A standard dual-monitor setup uses two monitors connected with two DVI or two DP outputs from your graphics card.

1. Connect the DVI or DP outputs to the two monitors. 

Tip: Use a calibrated monitor or projector for the footage monitor.

2. In SpeedGrade, click Settings > Display and adjust the settings under Window Size. 

The default values work for two displays with 1920x1080 resolution. SpeedGrade is displayed to the left of the display with the footage.

3. Select the Enable option.

Advanced dual-monitor setup

The advanced dual monitor setup uses nVidia Quadro SDI technology to allow for real-time 10- and 12-bit output over Single Link or Dual Link
SDI. The nVidia Quadro SDI setup requires a 64-bit Windows 7 system.

1. Connect the DVI or DisplayPort output to the display you want to use for the SpeedGrade workspace.
2. Use either a Single Link or Dual Link SDI output from the NVIDIA SDI card to connect with external waveform and other monitoring devices,

and your reference monitor or projector.
3. In SpeedGrade, select Settings > Display.
4. In the SDI Output section, change signal and format settings according to your desired output format settings.
5. Select the Enable option.

FAQ: How many outputs on the nVidia GPU can be used in parallel?

Only two outputs at a time can be used in parallel. The SDI card is routed through the Quadro GPU and thus takes one DVI or DP output. The
other output can be used for the workspace display. The additional DisplayPort is not active in parallel.

Tip: Combining local footage display with a projection setup

To give the operator an accurate local display in parallel to another display or projection system, a signal split on the SDI output is recommended.
This is the recommended way to monitor a signal through external waveform and vectorscope devices.
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Direct-Link workflow between Premiere Pro and SpeedGrade
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New in the October 2013 release of Premiere Pro CC (version 7.1) and SpeedGrade CC (version 7.1)

About Direct Link
Edit and grade Premiere Pro sequences with Direct Link
Open Premiere Pro projects directly in SpeedGrade
Limitations in Direct-Link mode

About Direct Link

The Direct-Link workflow is a new and integrated edit-and-grade workflow between Premiere Pro CC and SpeedGrade CC.

In the past, to use SpeedGrade to color grade your footage from Premiere Pro, you rendered and exported your sequences to SpeedGrade either
as DPX still image sequences or edit decision lists (EDLs). After completing color grading in SpeedGrade, you exported the projects as stand-
alone video files back into Premiere Pro for more editing.  

Direct Link offers a fast and efficient alternative to this workflow. Leveraging the power of the Mercury Playback Engine, Direct Link lets you send
or open Premiere Pro projects directly in SpeedGrade. You can color grade Premiere Pro sequences in SpeedGrade and send it back to Premiere
Pro in a few clicks.

To achieve optimal performance when using Direct Link, use an NVIDIA CUDA graphics card with GPU acceleration on Windows. For more
information about Adobe-certified NVIDIA graphics cards, see the Tech specs.

Edit and grade Premiere Pro sequences with Direct Link

The Direct-Link workflow lets you roundtrip Premiere Pro projects between editing and grading without time-consuming or complex tasks like
rendering and conforming.

 
Premiere Pro-SpeedGrade Direct-Link workflow
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Note:

Step 1: Select Premiere Pro sequence

Select the Premiere Pro sequence that you want to color grade.

Ensure that you have selected the sequence in the Timeline or Project panel.  

Step 2: Send sequence to SpeedGrade using Direct Link

Using Direct Link, you can send a sequence from an open Premiere Pro project directly to SpeedGrade without exporting the project.

To use Direct Link, select File > Direct Link To Adobe SpeedGrade.

Step 3: Choose to open sequence in SpeedGrade

When you select the Direct-Link workflow, Premiere Pro prompts you to save changes to the project in Premiere Pro and open it in SpeedGrade.
Click Yes.

Step 4: Selected sequence opens in SpeedGrade

Premiere Pro closes, and SpeedGrade opens the sequence in its Timeline, which uses the same familiar track layout as Premiere Pro.

In the SpeedGrade Timeline, you can see all the clip edit points, transitions, and layers.

 
Project Timeline in SpeedGrade

Step 5: Color grade the sequence using grading and mask tools

Within SpeedGrade, you can color grade the sequence using Looks and Masks. The Looks that you apply in SpeedGrade will appear as Lumetri
presets when you reopen the sequence in Premiere Pro.  

If a Lumetri Look has already been applied in Premiere Pro, it's available in the SpeedGrade Timeline, where you can adjust its parameters.
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A. Premiere Pro project sequence B. Premiere Pro sequence color graded in SpeedGrade 

The Direct-Link workflow has been designed to let you focus on the color correction and grading tasks when you are in SpeedGrade. Because of
this focus, only the Color and Look tabs in SpeedGrade are available in the Direct-Link mode. For more details, see Direct-Link workflow
limitations.

Step 6: Send the color graded sequence to Premiere Pro for editing

When you finish color grading your sequence in SpeedGrade, save and reopen the sequence in Premiere Pro for final output or further editing.

Click the Direct Link to Adobe Premiere Pro icon in the upper left of the SpeedGrade user interface.

 

The color graded sequence opens in Premiere Pro with all color grading fully intact.

Color grading and masks applied in SpeedGrade are visible in Premiere Pro as Lumetri effects. In Premiere Pro, you can turn these Lumetri
effects on or off for each clip and for each adjustment layer individually using the Effects Controls panel.

You continue editing or export your sequence for final output in Premiere Pro.

Open Premiere Pro projects directly in SpeedGrade

You can open native Premiere Pro projects directly in SpeedGrade, apply color grading changes, and reopen the project in Premiere Pro.

The SpeedGrade Welcome screen lets you:

Open a recently accessed Premiere Pro project (.pproj)
Open a Premiere Pro project (.pproj)
Create a new SpeedGrade project (.IRCP)
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When you open a Premiere Pro project, the Sequence Importer dialog opens showing all the sequences contained in the project. Select a
sequence to open.

SpeedGrade cannot open more than one Premiere Pro sequence at the same time.

Within SpeedGrade, you can apply primary and secondary color correction, apply Looks and Masks, and do all the required color grading.

You cannot send SpeedGrade (.IRCP) projects back to Premiere Pro. To use Direct Link you need to start with a Premiere Pro project
(.pproj).

Some important points:

From within SpeedGrade, you can view and adjust Premiere Pro adjustment layers, and also view any transitions applied to the sequence.
All the color grading that you apply in SpeedGrade is available automatically in Premiere Pro. There is no need to export the .look files.

Working with offline media

When you open a Premiere Pro project with missing media files in SpeedGrade, you cannot link and locate the offline media like you would in
Premiere Pro.

To relink the offline media, you must bring the the project back to Premiere Pro.

Working with After Effects Compositions

There are several ways to use After Effects Compositions in your Premiere Pro project:

Replace a clip in Premiere Pro with an After Effects Composition
Link to an After Effects Composition using Adobe Dynamic Link
Import an After Effects Composition (AEP file) into a Premiere Pro project

Irrespective of which method you use, you can open a Premiere Pro sequence containing After Effects Compositions directly in SpeedGrade.
SpeedGrade opens the sequence in Direct-Link mode, from where you can color grade the compositions just as you would color grade any
Premiere Pro sequence.

Limitations in Direct-Link mode

The Direct-Link workflow has been designed such that you focus only on the color correction and grading workflows within SpeedGrade.

Given this focus, there are specific things to consider while using SpeedGrade in the Direct-Link mode:

To use Direct Link, you start with a Premiere Pro project (.pproj). You cannot send SpeedGrade projects (.IRCP) to Premiere Pro in the
Direct-Link mode.
In the Direct-Link mode, you cannot render your Premiere Pro projects within SpeedGrade. You send the projects back to SpeedGrade for
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rendering. So, the Render and Results tabs are unavailable when using Direct Link.
SpeedGrade can open only one Premiere Pro sequence at a time, and not multiple sequences at once. To open a different sequence in the
project, open the Sequence Importer dialog by clicking  in the SpeedGrade Timeline.
You cannot launch the Media Browser to browse through media, so the Media tab is unavailable when using Direct Link.
You cannot add clips to the Premiere Pro sequence within SpeedGrade. You have to bring the project back to Premiere Pro to edit the
sequence.
You cannot adjust audio or use the Pan & Scan functions. So, Stereo 3D, Audio, and Pan And Scan tabs are unavailable when using Direct
Link.
If you apply the Warp Stabilizer effect on a Premiere Pro sequence, ensure that the analysis is complete before sending the sequence to
SpeedGrade using Direct Link. Otherwise, an error message appears.  
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Image analysis tools
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New in SpeedGrade CC

Histogram
Vectorscope
RGB Parade
Channel views

SpeedGrade provides various tools, like the following, to analyze your image:

Histogram
Vectorscope
RGB Parade
Luma Waveform

These tools are now grouped together and available from the Analysis Tools panel.

To display the Analysis Tools panel, use the keyboard shortcut A, or click the arrow on the upper-left Monitor panel. You can adjust the size of the
Analysis Tools panel using the drag handles.

Use the context menu to choose which video scope you want to view.

 
Analysis Tools panel

Histogram

Histogram shows RGB values. The minimum Luma values per channel are displayed as numerical feedback at the bottom. Maximum values are
displayed at the top. Two horizontal lines indicate the output range. The default range is set to CIN code values (95 - 685).

43



To the top

To the top

 
Histogram

Vectorscope

Vectorscope works in HLS (Hue, Lightness, Saturation) mode. The Vectorscope displays the video’s chrominance information in a a circular chart.
Saturation is measured from the center of the chart outward.

 
Vectorscope

RGB Parade

RGB Parade scope displays separate waveforms for the red, green, and blue components of an image. The waveforms are displayed side by
side, making it easy to compare the relative levels of reds, greens, and blues in an image, and make adjustments as required. The RGB Parade
scope also makes it easy to spot color casts in your image.

 
RGB Parade
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Luma Waveform

The Luma Waveform scope displays a representation of the luminance of your images.

High luma levels appear as spikes on the waveform, and low luma levels appear as dips. This lets you quickly identify highlights and shadows in
your image, helping you achieve precise black-and-white balancing.

 
Luma Waveform

Channel views

Use channel views to check specific color channels. For example, you can use it to check for compression artifacts or noise in the RGB channels.

To see a channel on the Monitor, follow these steps:

1. Select the Timeline tab, and then select View.
2. Select a channel from the Channel View menu under Display Options. 

For example, if your image includes an alpha channel, select Alpha Channel to view on the Monitor. To switch back to normal view, select the
channel view as Normal View.
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Adjust the display resolution for playback
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Note:

SpeedGrade dynamically adjusts the quality of video to ensure smooth playback on computers with less capable graphic cards or CPUs. To
optimize performance, you can set the quality settings for the image both during playback and when paused.

Test the performance of your system during playback and then adjust the settings accordingly.

1. Click the Settings menu on the upper-right corner of the screen, and then select the Dynamic Quality option.

 

2. Select a lower resolution for playback, such as 1:2 (half the resolution of the source material) or lower.

3. Set the resolution for paused images.

Use the paused image resolution to see more image detail. Set it as high or higher than the selected playback resolution.

4. If working with formats that have a native color depth greater than 8 bits per channel, you can set the color depth for playback and paused
images as well.
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Crop the display frame
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You can set the display size of your frames by cropping them in the monitor.

Cropping frames in the monitor does not modify the source material. Instead, the frame hides parts of the image. Color corrections are still
applied to the parts of the image hidden by the frame.

If you want to resize the display frame and keep the entire image in the frame, see Adjust the display aspect ratio.

1. With a clip on the Timeline, click the View button on the Timeline panel.

 

2. In the Display Options section, click the icon on the left side of the Crop menu.

The button toggles the Crop menu.

 

3. Select a crop preset from the menu.

4. To turn off the crop preset, click the icon again.
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Adjust the display aspect ratio
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Note:

You can correctly display anamorphic and other non-square-pixel aspect ratio footage in the Monitor by changing the display aspect ratio.

Changing the display aspect ratio does not modify the source material.

1. With a clip on the Timeline, click the View button on the Timeline panel.

 

2. In the Display Options section, click the icon on the left side of the Aspect Ratio menu.

The button toggles the Aspect Ratio menu.

 

3. Change the display aspect ratio by selecting an option from the menu.

4. To switch to the default aspect ratio, click the icon again.

Related links
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Work with keyframes
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Add keyframes
Workflow for creating dissolves between keyframes
Automatically record keyframes when editing
Move between keyframes
Delete keyframes
Related topics

Use keyframes to transform the state of a grade, mask, or pan-and-scan adjustment over time. A keyframe marks the point in time where you
specify a state, such as the position of a mask. You typically use at least two keyframes—one for the state at the beginning of the change, and
one for the new state at the end of the change. You can add as many keyframes as you need on a track. SpeedGrade interpolates the values
between keyframes and creates dissolves between them.

Add keyframes

Every new grading track has one keyframe at its start position. If you don’t add more keyframes, any adjustments affect the whole clip.

To add more keyframes along a track:

1. Move the playhead to the position you’d like to add a keyframe.

2. Click the Record Keyframe button.

 

3. Apply adjustments at the new keyframe position, such as a grade, mask, or pan-and-scan adjustment.

4. With the playhead at the current keyframe, click the Record Keyframe button a second time to create a dissolve from the previous keyframe
to the current keyframe. See Workflow for creating dissolves between keyframes.

An arrow between the keyframes on the track indicates a linear dissolve between the two positions.
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Workflow for creating dissolves between keyframes

Create a dissolve between two keyframes by clicking the Record Keyframe button a second time at each new keyframe position. The typical
workflow is as follows:

1. Move the playhead to the position on the timeline where you want to start the dissolve.

2. Add a keyframe by clicking Record Keyframe.

3. Move to the playhead to the position on the timeline where you want to end the dissolve.

4. Click on Record Keyframe twice to add a keyframe that will smoothly morph all settings from the previous to the current keyframe.

5. Adjust your grade, mask, or pan-and-scan at the two keyframe positions.

Automatically record keyframes when editing

When Auto-keyframe mode is on, modifying a property automatically adds a keyframe at each new position.

Click the Auto-keyframe button to toggle Auto-keyframe mode on or off.

Move between keyframes

Press the left or right arrow buttons on the keyframe toolbar.

Tip: You can also use the following keyboard shortcut: Ctrl+Shift+Left/Right Arrow.

Delete keyframes
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To delete one keyframe:

1. Navigate to the keyframe you want to remove.

2. Click the delete keyframe button.

 

Other keyframes on the same track are not affected.

To delete all keyframes on a track:

Click the Delete All Keyframes button.

 

Keyframes on other grading, mask, or pan-and-scan tracks above or below the current grading clip are not affected.

Related topics

Color grade a clip
Track a masked object through a shot
Adjust the framing of shots with pan and scan
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Keyboard shortcuts

To the top

To the top

Application shortcuts
Playback shortcuts
Keyframe shortcuts
Pan and zoom view shortcuts
Splitscreen view shortcuts
Timeline and navigation shortcuts
In- and out-point shortcuts
Grading shortcuts
Look browser, Snapshot browser shortcuts
Continuity Checker, Automatic Shot Match shortcuts
Gray-out shortcuts
Editorial shortcuts
Analysis tools shortcuts
Channel view shortcuts
Stereoscopic viewing shortcuts

For the F-key shortcuts to work on Mac OS systems, you must disable the default Function key assignments. In System Preferences, select
Keyboard, then the Keyboard Shortcuts panel. Select Expose & Spaces and deselect the key assignments.

Application shortcuts

Playback shortcuts

Result Windows Mac OS

Show Help F1 F1

Show or hide grading panels P P

Show or hide Settings window S S

Show Desktop D D

Save Timeline Ctrl+S Cmd+S

Show or hide Render window Ctrl+R Cmd+R

Close application Alt+F4 Cmd+Q

Toggle Fullscreen mode Alt+Enter or F Alt+Enter or F

Escape fullscreen view Esc or Shift+H Esc or Shift+H

Show or hide Metadata display M M

Toggle mouse between main and SDI
display

Shift+X Shift+X

Reconnect CP200 panels Alt+F12 Alt+F12

Show or hide Dual DVI window
(toggle)

Shift+Ctrl+Alt+D Shift+Ctrl+Alt+D

Show the Reel browser Ctrl+Alt+R
Cmd+Alt+R

 

Close Settings window Esc Esc
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Keyframe shortcuts

Pan and zoom view shortcuts

Result Windows Mac OS

Play/Pause Space Space

Reverse playback Shift+Space Shift+Space

Step back one frame Left Arrow Left Arrow

Step forward one frame Right Arrow Right Arrow

Decrease playback FPS PgDn PgDn

Increase playback FPS PgUp PgUp

Double frames per second Numpad * Numpad *

Halve frames per second Numpad / Numpad /

Switch between single play, loop, and
ping-pong playback mode

F6 F6

Mirror image horizontally Alt+M Alt+M

Mirror image vertically Shift+M Shift+M

Clear memory (unload all frames) Shift+Ctrl+F5 Shift+Cmd+F5

Reload changed frames from disk F5 F5

Playback forward L L

Playback backward J J

Stop K K

Result Windows/Mac OS

Add a keyframe F2

Remove a keyframe Shift+F2

Go to the previous keyframe F3

Go to the next keyframe F4

Result Windows Mac OS

Pan up/down Shift+Up/Down Arrow Shift+Up/Down Arrow

Pan left/right Shift+Left/Right Arrow Shift+Left/Right Arrow

Reset pan Shift+Home Shift+Home

Match channel sizes Alt+Home Alt+Home

Zoom in/out Numpad +/- Numpad +/-

Zoom to 100% Shift+Ctrl+Home Shift+Cmd+Home

Zoom to fit Ctrl+Home Cmd+Home
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Splitscreen view shortcuts

Timeline and navigation shortcuts

In- and out-point shortcuts

Grading shortcuts

Result Windows Mac OS

Change the splitscreen mode F9 Cmd+F9

Change the vertical/horizontal
orientation of the split screen

F10 Cmd+F10

Switch the channel positions in the
split screen

F11 Cmd+F11

Result Windows Mac OS

Next/previous clip Ctrl+Right/Left Arrow Cmd+Right/Left Arrow

Select previous clip Shift+Ctrl+Left Arrow Shift+Cmd+Left Arrow

Select next clip Shift+Ctrl+Right Arrow Shift+Cmd+Right Arrow

Select clip below Shift+Ctrl+Down Arrow Shift+Cmd+Down Arrow

Select clip above Shift+Ctrl+Up Arrow Shift+Cmd+Up Arrow

Center master playhead Ctrl+Numpad 0 Ctrl+Numpad 0

Move master playhead to selected clip Alt+Numpad 0 Alt+Numpad 0

Isolate current clip (sets In/Out points
to current clip)

Note: Press again to restore previous
In/Out positions.

 

Ctrl+Spacebar  Ctrl+Spacebar

Result Windows, Mac OS

Set in-point at current master playhead position I

Set out-point at current master playhead position O

Move master playhead to current in-point Shift+I or Home

Move master playhead to current out-point Shift+O or End

Reset in- and out-points to default positions Shift+Ctrl+Alt+O

Reload replaced frames on disk Shift+F5
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Look browser, Snapshot browser shortcuts

Continuity Checker, Automatic Shot Match shortcuts

Result Windows Mac OS

Apply previewed preset to the timeline Enter Enter

Reject previewed preset Backspace Backspace

Change color selector mode Shift+Enter Shift+Enter

Reset grading on current clip Shift+Alt+Delete Shift+Alt+Delete

Reset grading on current panel Alt+Delete Alt+Delete

Copy grade from the previous or next
9 edits

Alt+[Numpad]1 to 9 Alt+[Numpad]1 to 9

Set the Copy Grade Feature to copy
from next edits

Alt+[Numpad] + Alt+[Numpad] +

Set the Copy Grade Feature to copy
from previous edits

Alt+[Numpad] - Alt+[Numpad] -

Copy grade from clip below mouse
position

C C

Toggle grading on/off 0 (zero) 0 (zero)

Disable grading (hold down) [Numpad] 0 [Numpad] 0

Disable grading on current panel (hold
down)

[Numpad] , [Numpad] ,

Navigate layer stack up/down Ctrl+Up/Down Arrow Cmd+Up/Down Arrow

Result Windows Mac OS

Navigate through the Look Browser Alt+Left/Right/Up/Down Arrow Alt+Left/Right/Up/Down Arrow

Toggle Looks Management Browser
on/off

Ctrl+L Command+L

Navigate through the Snapshot
Browser

Shift+Alt+Left/Right/Up/Down Arrow Shift+Alt+Left/Right/Up/Down Arrow

Add or toggle snapshot Shift+C Shift+C

Collapse the third panel in the
Snapshot Browser

W W

Result Windows Mac OS

Add one or more playheads while
using the Continuity Checker

Alt+1/2/3 Option+1/2/3

Use the Auto Shot Match feature Ctrl+M Command+M
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Gray-out shortcuts

Editorial shortcuts

Analysis tools shortcuts

Channel view shortcuts

Result Windows Mac OS

Turn on gray-out Ctrl+G Cmd+G

Turn on black-out Alt+G Alt+G

Turn on white-out Ctrl+Alt+G Cmd+Alt+G

Turn off gray-out Shift+Alt+G Shift+Alt+G

Result Windows Mac OS

Toggle selected dissolve clip’s
direction (bottom-to-top/top-to-bottom)

Shift+D Shift+D

Split currently active clip and all clips
directly above it at the master
playhead position

Shift+Alt+S Shift+Alt+S

Splits currently active clip at the
master playhead position

Ctrl+Alt+S Cmd+Alt+S

Result Windows, Mac OS

Open Analysis Tools panel A

Toggle Histogram H

Toggle Waveform W

Toggle Vectorscope V

Result Windows, Mac OS

Show red channel R

Show green channel G

Show blue channel B

Hide red channel Shift+R

Hide green channel Shift+G

Hide blue channel Shift+B
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Stereoscopic viewing shortcuts

Result Windows, Mac OS

Right eye Left Alt+R

Left eye Left Alt+L
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Loading footage

Loading and conforming material
Patrick Palmer (Jun. 17, 2013)
video-tutorial

Using scene change detection
Patrick Palmer (Mar. 23, 2012)
video-tutorial
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Supported file formats
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Frame sequence formats
Movie file formats
RAW file formats

Frame sequence formats

Movie file formats

RAW file formats

Format Read Write

Cineon Yes Yes

DPX, DPX 2.0 Yes Yes

Targa Yes Yes

JPEG Yes Yes

PNG Yes Yes

TIFF Yes Yes

Pixarlog TIFF Yes No

Floating Point TIFF Yes Yes

Maya IFF Yes Yes

Lightwave IFF Yes Yes

RGB (SGI) Yes Yes

Softimage PIC Yes Yes

Wavefront RLA Yes Yes

Wavefront RPF Yes No

Windows Bitmap Yes Yes

GIF Yes No

Cinema DNG Yes Yes

OpenEXR Yes Yes

Format Read Write

Windows AVI Windows only Windows only

Quicktime Yes Yes
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The supported RAW formats are read-only.

ARRI Alexa .ari
ARRI D21 .ari
Phantom HD / GOLD / FLEX / 65 (.cine)
REDCode RAW (.r3d)
Silicon Imaging SI 2K/SI Mini (Uncompressed .siv)
Weisscam HS-1/HS-2 RAW (.wcr)
Weisscam HS-2 Digimag (.fhg*)
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Load footage
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Load items
Load multiple items at once
Insert items between clips

Load items

Add items to the Timeline as follows.

Navigate to the item in Desktop view, then double-click the thumbnail. You can also drag an item to the Timeline.
Repeat the process to add more items. Each item is placed after the last item on the Timeline.

Related links

Load multiple items at once

Loading multiple items at once is useful when loading RAW data for creating dailies to create a virtual lab reel.

1. In Desktop view, browse to the folder with the items you want to add to the Timeline.

2. Click Add All on the lower-right side of the Desktop.

 

SpeedGrade adds all the files to the Timeline in order of appearance.

Insert items between clips

1. Drag the thumbnail from the Desktop view to the position on the Timeline where you’d like to place it.
2. When a highlighted red line appears at the desired location, release the mouse button.

61

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/en_US/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy


Conform EDLs

Note:
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Master-clip workflow
Multiple-clip workflow
Supported EDL features

Edit Decision Lists (EDLs) are metadata documents used to migrate project timelines from other editing tools.

Timelines created from EDLs in SpeedGrade adhere to the Sony CMX 3600 standard. SpeedGrade also supports the extended 16-digit EDL to
work with ARRIRAW and Red R3D material.

The two most common scenarios for conforming EDLs are as follows:

You have an EDL and one long image sequence or movie file with all the edits baked in. You want to use the EDL to create keyframes to cut
the clip into individual edits. See Master-clip workflow.
You have an EDL with online material in several folders or consisting of individual movie files. You want to associate the correct online clips
according to the Reel ID/filename information available in the EDL. See Multiple-clip workflow.

Before working with EDLs, make sure to set the correct frame rate preset in SpeedGrade. For example, if your project is based on 24 fps,
set both your preset for new timelines and your base fps to 24. For instructions, see Playback basics.

Master-clip workflow

Follow this workflow if you have one long clip of online material and want to use an EDL to cut it into individual edits.

1. Locate the pre-conformed clip in the Desktop view and drop it on the Timeline.
2. Locate the EDL in the Desktop view and drop it on the clip in the Timeline.

SpeedGrade cuts the clip into edits.

Multiple-clip workflow

1. Locate the EDL in the Desktop view and drop it on the Timeline.

SpeedGrade inserts placeholder clips on the Timeline representing all the edits. The clips are red because the reels are not loaded yet.

2. Use the Desktop to locate the footage that represents the reels.

Use the filter options to search subfolders or to treat folders as reels. For example, if all the material is in one folder structure, select the
Sequences from Folder + Subtree filter option.

3. Click Load from Desktop to connect the source clips to the placeholder clips.
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Reel ID

CLIP NAME

Replacements

FLIPS AND FLOPS

M2 (Time Warp)

K (Key)

 

To prevent reels on the Timeline from being replaced when adding new reels from other locations, select the Don’t Replace Loaded Reels
checkbox.

4. If your material is in several folders, repeat the process with the other folders.

About footage references

An EDL can reference footage with a clip name and reel ID. If the reel ID information is not present, SpeedGrade can use the clip name. If both
are present, SpeedGrade references the reel ID first

Sometimes, the reel ID and clip name information don’t match and the footage can't be associated automatically. In this case, you can drop
material manually from the Desktop on the placeholder reels.

Dissolves

Dissolves between clips according to an EDL are available as A and B layer with a dissolve layer in between. All three layers are generated
automatically when conforming an EDL.

Supported EDL features

The CMX reel ID is the primary means of identification for a clip. If possible, place reel footage in subfolders with the Reel ID provided in
the 3600 EDL.

SpeedGrade supports the FROM CLIP NAME syntax in a CMX comment. Clip name is the secondary means of identification for a
clip. If the Reel ID provided is not found or the Reel ID is AX, the clip name is used.

The syntax REEL AX IS CLIP is supported.

Vertical and horizontal mirroring is supported. The FLIP, FLOP, and FLIP-FLOP comment keywords are evaluated.

M2 speed change/time warp commands are supported. Reverse playback is supported.

Key commands are not supported and result in an error at load time.
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Load audio tracks
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1. Open the Desktop view and browse to an audio file (wav or aiff file).

2. Drag the file on the Timeline.

Green tracks represent audio clips.

 

3. Adjust the position of the audio clip along the Timeline.

4. Enable and disable the audio of a selected track by clicking the speaker icon on the left side of the Timeline.

 

5. To change values for sound output, such as the mixing frequency, select Settings > Sound.

The Settings menu is on the upper-right corner of the SpeedGrade workspace.
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Detect scene changes
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Detect scene changes
Prepare the footage for grading or editing
Save or export the footage

You can automatically detect scene changes in footage that does not have an EDL, such as archived material. Once SpeedGrade has identified
scene changes, you can add keyframes to scene changes, or split your footage up into separate clips.

The workflow consists of the following steps:

1. Detect the scene changes.
2. Prepare the footage for grading or editing.
3. Save or export the footage.

Detect scene changes

1. Select your footage on the Timeline.

2. Click the Timeline tab and select the Setup panel.

3. Under Tools, click Scene Change Detect.

The Scene Change Detect dialog box opens and SpeedGrade automatically scans your footage for scene changes.

 

4. When the scan is complete, you can review the results using the arrow buttons on the left side of the dialog box.

Step through frames to review the content.
To confirm scene changes, select the This Frame is a Scene Change checkbox.
Use the checkbox to add scene changes.

5. If necessary, you can adjust scene detection sensitivity and click Rescan Clip.

Prepare the footage for grading or editing
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After marking your scene changes, prepare the footage for grading or editing as follows:

To separate the footage into individual shots or scenes, click Split into Clips.
To flag the scene changes, click Add Keyframes to Clip.

Save or export the footage

Once you split into clips or add keyframes, you can save the scene-detected content as a SpeedGrade project or create an Edit Decision List
(EDL).

In the Setup Panel under the Timeline tab, do one of the following:

To save the content as a SpeedGrade project, click Save IRCP.
To export an Edit Decision List, click Save EDL.
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Display burn-in information on frames
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Note:

To the top

Display burn-in information during playback
Display burn-in information on the rendered output

You can "burn" (overlay) metadata information on your frames during playback or on the rendered output. For example, selecting the Standard
burn-in preset in SpeedGrade superimposes the following information on the footage:

Current frame number
Location on disk of current sequence
Native time code of current frame (assuming the information exists in the header of the file format you’re using)

Display burn-in information during playback

1. In the Timeline tab, select the View pane.

2. Under Display Options, select a burn-in preset from the Burn In menu.

If the menu is inactive, click the Burn-in tool to make it active.

 

Display burn-in information on the rendered output

Including burn-in information on rendered output can be useful when creating proxy media for offline editing or dailies for review.

When setting the rendering options in the Output panel, select a burn-in preset from the menu.
In the Flash Burn-In For text box, set the number of frames to display the burn-in information. The default setting is 0, meaning burn-in
information is included on all rendered frames.
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Color grading

Secondary color correction
Patrick Palmer (Jun. 17, 2013)
video-tutorial

Adding impact to your footage
Patrick Palmer (Jun. 17, 2013)
video-tutorial

Two approaches to structuring your grade
Patrick Palmer (Jun. 17, 2013)
video-tutorial

Stereoscopic workflows
Patrick Palmer (Jun. 17, 2013)
video-tutorial

68

http://tv.adobe.com/watch/learn-speedgrade-cs6/secondary-color-correction-in-speedgrade-cs6/
http://tv.adobe.com/watch/learn-speedgrade-cs6/adding-impact-to-your-footage-with-speedgrade-cs6/
http://tv.adobe.com/watch/learn-speedgrade-cs6/two-approaches-to-structuring-your-grade-in-speedgrade-cs6/
http://tv.adobe.com/watch/learn-speedgrade-cs6/stereoscopic-workflows-in-speedgrade-cs6/


Continuity Checker and Shot Matcher
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New in SpeedGrade CC

Continuity Checker

When shooting video, you can have unintended color variations from one shot to another. SpeedGrade lets you even out these differences, and
balance the clips such that the video flows smoothly from one clip to the next.

You can quickly compare multiple shots on the timeline using the Continuity Checker, and match the color grading as required. The Continuity
Checker is often used in combination with the Shot Matcher feature.

Using Continuity Checker

1. Position the master playhead on a timeline that contains two or more clips.

2. To compare two shots, click 2-Up in the Monitor panel. You can also use the keyboard shortcut Alt+2 (Win)/Option+2 (Mac).

To compare three shots, click 3-Up in the Monitor panel, or use the keyboard shortcut Alt+3 (Win)/Option+3 (Mac).

To remove the additional playheads and view only the current clip, deselect 2-Up or 3-Up, as required. You can also use the keyboard
shortcut Alt+1(Win)/Option+1(Mac).

 
Review sequential clips with Continuity Checker to ensure grading consistency

3. You can view multiple shots on the Monitor panel using the Split-screen option, and see the continuity across shots.

4. To match the shots and grade the clips, turn on Shot Matcher by clicking Match in the Monitor panel.

Shot Matcher

SpeedGrade provides you with a feature called Shot Matcher that lets you automatically match color between two video shots from the same or a
similar scene. For example, you can quickly correct underexposed or overexposed footage by using another shot as reference.
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Note:

The Shot Matcher feature works best when used in combination with the Continuity Checker. You can use the Continuity Checker to compare the
two shots, and then match the color between the shots using Shot Matcher.

For example, say, you have shot a video in different light conditions, and you want to match the skin tone of the model between two shots in the
same scene. You can compare the two shots using Continuity Checker, and then match the color between shots using Shot Matcher.

See the example images below that demonstrate how the Shot Matcher feature can dynamically color match your footage.

 
Display the snapshots to match side-by-side

When you use Shot Matcher, SpeedGrade adds an adjustment layer to your grade for that clip. You can adjust the opacity or add additional
corrections as required.

 
Using Shot Matcher to automatically match shots and speed up basic color correction

If you try to match shots between two distinctly different scenes, you can get inappropriate results.

Using Shot Matcher

Move the playhead to the frame in your sequence that you want to match. Say, Clip A.

1. Move the playhead to the frame in your sequence that you want to match. Say, Clip A.

2. Create a second playhead. To do so, press the Control (Windows) or Command (Macintosh) key and drag the Move Playhead icon to the
required frame in the Timeline. For more information, see Create an additional playhead.
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Note:

Note:

3. Make sure that you move the second playhead to the correct frame to be matched. Say, Clip B. When you do so, the two snapshots to
match (Clip A and Clip B) are displayed side-by-side or in a split-screen layout

Shot Matcher works only when you use two playheads. If you try to use three or more playheads, the Shot Matcher feature is
disabled.

4. Select the playhead on the clip to match as the master playhead. For example, select Clip A as the master playhead.

To select a playhead as the master playhead, click the playhead number. For more information, see Select a master playhead.

5. Click the Match button or use the keyboard shortcut Control (Windows)/Command (Mac)+ M.

A new grading layer "AutoColorMatch" is automatically added to the grading layer stack. You can then enable, disable, remove, or save the
look as a preset.

Matching a Photoshop grade

You can now apply a color grade that you create in Adobe Photoshop to your video clip by following these steps:

1. In Photoshop, use all the necessary tools to grade the image, and save the image as a TGA file.
2. In SpeedGrade, reference the TGA file using the new Snapshot browser. A thumbnail of the graded image appears.
3. Move the playhead to the frame in your sequence that you want to match.
4. Click the thumbnail to view the graded Photoshop image in the Monitor view side-by-side with the clip to match.
5. Click Shot Matcher. 

SpeedGrade extracts the color grading of the Photoshop image and applies the grading to the selected clip.
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Quickstart: Color grade a clip
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Select a clip
Apply a primary color grade
Apply a secondary color grade
Render a graded clip

To load an EDL and color grade a sequence, see Color grade a sequence.

Select a clip

1. In SpeedGrade, select a folder that contains video clips using the file browser in the upper-left corner of the user interface.

The Desktop window shows thumbnail versions of the content in the selected folder.

To filter the thumbnails by file type, select All Files in the upper-right corner and then select a file type.

2. Place a clip on the Timeline by double-clicking it on the Desktop.

3. Click the Monitor Tab in the upper-left corner to view the image.

The default display size is 100%. To fit the image in the monitor window, click the Zoom to Fit button below the scopes window on the
right side of the interface.

 

Apply a primary color grade

Make basic color changes like temperature, white point, black point, and more, to the entire image. The changes are applied to a primary
grading layer.

Access the grading controls by clicking the Look tab in the lower left, below the timeline.

 

72



To the top

Make global changes

Make global changes to the image with the sliders at the top of the Look panel.

Global adjustment sliders

To adjust a global setting, do the following:

1. Right-click the triangle icon on the slider and release the click button.
2. Swipe the mouse left or right to change the value.
3. Right-click the triangle icon again to accept the setting.

Make changes to specific regions

Modify color and luminance values in the image's shadow, midtone, and highlight regions using the color control wheels on the Look panel.

Color control wheels

To adjust the luminance, do the following:

Left-click the triangle icon on a wheel and drag the mouse left or right in a straight line. Don't drag the mouse in a circle. The further left or
right you drag, the larger the change.

To adjust the color, do the following:

1. Right-click inside the circle and release the click button.
2. Swipe the mouse in any direction to change the value.
3. Right-click again to accept the setting.

You can use color sliders instead of control wheels. To access the sliders, press Shift+Enter.

Color sliders

Use the zero (0) key on the numeric keypad to toggle the grade on and off for a quick before and after view. Make sure the NumLock key on
your keyboard is selected.

Apply a secondary color grade
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Make targeted adjustments to a specific hue range in the image. The changes are applied to a secondary grading layer.

1. Access the secondary color grading tools by selecting the +S icon in the lower-left corner of the Layers window.

 

2. Select a hue range as follows:

Select a preset hue option by clicking one of the colored buttons along the top of the Hue selection tool.
Sample a hue range by clicking the eyedropper tool with the + icon and then dragging to select a portion of the image in the Monitor
window.

You may have to resize the lower border of the Desktop window to see the eyedropper tools. To resize the window, use the drag
resize tool located at the bottom center of the Timeline.

 

3. View the portion of the image targeted by the hue range selection by selecting an option from the Gray-out menu at upper-right corner of
the Look tab.

 

4. Make adjustments and refinements to the selection using the upper triangles of the sliders. Use the lower triangles of the sliders to adjust
fall-off.

5. Make secondary corrections with the Off-set and Gain control wheels in the center of the Look window.

6. Soften and blend secondary corrections using the Denoise and Blur sliders on the right of the Look window.

7. After making secondary corrections, set Gray-out to None.
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Render a graded clip

1. Click the Output tab in the upper-right corner to open the Metadata Render Engine.

 

2. Click the Desktop menu and select a destination folder.

3. Assign a name to the rendered file in the File Name textbox.

4. In Format & Options, select a output file format for the render.

If a desired preset doesn’t exist, create a new one by clicking Other.

5. Click Online Quality in the Render section.

6. Click Render.
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Quickstart: Color grade a sequence
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The workflow for color grading a sequence consists of the following steps:

Load an EDL
Reconnect the source clips in the reels
Create a grading clip
Apply color grades to a grading clip
Apply a grading clip to additional video clips
Render a graded sequence

Load an EDL

Edit Decision Lists (EDLs) are metadata documents used to migrate project timelines from editing tools like Adobe Premiere Pro to post-production
tools like SpeedGrade.

Tip: Before starting, place the source clips and the EDL file in a single folder. This organization makes the process quicker and more efficient.

1. In SpeedGrade, select the folder containing the EDL file with the file browser in the upper-left corner of the user interface.
2. Double-click the EDL file to load it.

Tip: If you have too many thumbnails, you can filter them for EDL files by selecting the EDL option from the All Files menu in the upper-right
corner.

SpeedGrade places placeholder thumbnails in the video track and in the Reels panel. The Reels panel is on the Timeline tab on the lower left of
the screen.

Reconnect the source clips in the reels

The Reels panel gives an overview of the reels in an EDL. When loading an EDL, SpeedGrade inserts placeholder thumbnails of the source clips
in the Reels panel. Reconnect the source clips to the placeholder thumbnails in the Reels panel as follows.

1. If not already done, display the source clips on the Desktop window by selecting the folder containing the source clips.

2. Filter the thumbnails for the media type of the source clips. Example: QuickTime movies.

3. Click the Timeline tab and then click the Reels panel to view the source clip placeholders.

4. Reconnect the source clips to the thumbnails by clicking Load from Desktop. SpeedGrade reconnects the source clips on the Desktop and
the video track.
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Create a grading clip

When color grading a sequence, work in a non-destructive grading clip associated with the video clips in the sequence. Don't grade the video
clips directly. The grading clip can be saved, moved, and applied to multiple video clips. Grading clips are managed in the Timeline in a grading
track above the video track.

To create a grading clip, click the Setup button on the Timeline tab and do one of the following:

To create a series of grading clips in the grading track, click the Extract Grade Clips button in the third column of the Setup window.

 

To create a grading clip for a single video clip, drag the Grading Clip tool into the grading track above the target clip.

 

To add grading clips for all the video clips in the video track, drag the Grading Clip tool on a video clip in the video track.

Apply color grades to a grading clip

1. Select a grading clip in the Timeline, not a video clip.
2. Apply color grades to the selected grading clip. For more information on grading, see Color grade a clip.

The grade is applied to all the video clips sharing the grading clip.

Tip: Compare video clips for shot-to-shot color matching by using multiple playheads. For details, see Compare shots with multiple playheads.

Apply a grading clip to additional video clips

You can apply a single look to additional video clips on the Timeline.
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1. Drag the Grading Clip tool from the Timeline tab into the grading track above a video clip.

2. Drag the right side of a grading clip to cover multiple clips.

 

Grades in the grading clip are applied to any video clips below it.

Render a graded sequence

1. Click the Output tab in the upper-right corner to open the Metadata Render Engine.
2. Click the Desktop menu and select a destination folder.
3. Assign a name to the rendered file in the File Name text box.
4. In Format & Options, select an output file format for the render.
5. Click Online Quality in the Render tab.
6. Click Render.
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Track a masked object through a shot
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Note:

Track the masked object automatically
Control the movement of a mask manually

Track the masked object automatically

1. On the first frame of the track, apply a mask on the target object and grade it. 

For instructions, see Apply a mask.

2. In the Mask panel, click the Track Object button. 

The button is on the lower-right side of the Mask panel. You might need to scroll the panel down to see it.

The mask automatically tracks the target object through the shot.

See the next section if the following applies:

The mask can't follow the object after clicking the Track Object button
You want the tracking to begin or end later in the shot

Control the movement of a mask manually

Use keyframes to manually control the position of a mask over time. A keyframe marks the point in time where you specify the shape or position
of the mask. You typically use at least two keyframes—one for the position at the beginning of the change, and one for the new position at the end
of the change. SpeedGrade animates the transition between the keyframes. For more information, see Work with keyframes.

Keyframes are useful when the target object cannot be followed automatically. You can also use keyframes to change the shape and feather of a
mask over time.

1. In the Mask panel, do the following:

a. Move the playhead to the position on the timeline where you want the mask to start tracking the object.
b. Click the Record Keyframe button to insert a keyframe.

 
Record keyframe button

You don’t have to insert a starting keyframe if you want the mask to track the target object from the first frame of the track.
SpeedGrade adds a keyframe to the first frame as soon as you add a grading clip.

2. Apply a mask over the target object at the keyframe, and then grade the mask in the Look panel.

For instructions, see Apply a mask.

If you want the mask to track the object automatically from that point forward in the shot, click the Track Object button on the lower-right

79



  Twitter™ and Facebook posts are not covered under the terms of Creative Commons.

Legal Notices   |   Online Privacy Policy

side of the Mask panel.

3. Insert a second keyframe in the timeline as follows:

a. Switch to the Mask panel and move the playhead to the second position on the timeline where you want the movement of the mask to
end.

b. Click Record Keyframe.

4. Reposition the mask over the target object at the second keyframe.

5. To create a dissolve between the two keyframes, click the Record Keyframe button a second time on the second position.

SpeedGrade indicates the dissolve with an arrow on the track between the two positions.

6. If necessary, add more keyframes and adjust the position of the mask at each keyframe.

Related links

80

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/en_US/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy


Adobe Premiere Pro and SpeedGrade workflows
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Enhanced in SpeedGrade CC

General editing and grading workflow
Offline editing and grading workflow

The color grading process is usually the last step in the post-production workflow. If working with high-resolution material or RAW files, you can
begin your workflow by creating smaller proxy files in SpeedGrade for offline editing in Adobe Premiere Pro. After your editing is complete, you can
relink the edits to the source material in SpeedGrade for grading and finishing.

General editing and grading workflow

1. Edit in Adobe Premiere Pro.

2. Send the footage to SpeedGrade as follows:

If working with compressed files, use File > Send to Adobe SpeedGrade. Premiere Pro renders out a DPX sequence and opens it in
SpeedGrade.

Note: Because a DPX sequence is created, this option is more suitable for shorter projects where you have picture lock and are ready
for finishing.

If working with RAW files or on a larger project, export an EDL. See Export a project as an EDL file in Adobe Premiere Pro Help.

3. Load the material in SpeedGrade and apply color corrections.

4. Render out to your final output file format.

5. Render out a DPX sequence for storage.

You can also import the DPX sequence into Premiere Pro for finishing work such as adding titles and final audio, and then exporting a
final master. Importing an uncompressed DPX sequence preserves quality in the event you want to export from Premiere Pro again.

Post-production workflows between SpeedGrade and Adobe Premiere Pro
Color grading Premiere Pro sequences in SpeedGrade (Video tutorial)

Offline editing and grading workflow

The offline workflow is useful when working with high-resolution material or RAW files.

1. Load the source footage into SpeedGrade.
2. Apply any basic first-light color corrections.
3. Render out proxies. See Create proxy files for offline editing.
4. Import the proxies in Premiere Pro and edit the footage.
5. From Premiere Pro, export an EDL. See Export a project as an EDL file in Adobe Premiere Pro Help.
6. In SpeedGrade, use the EDL to relink the source files. See Conform EDLs - Multiple-clip workflow.
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7. Apply final color corrections to the full resolution source footage.
8. Render out to the file format for your output.

82

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/en_US/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy


Adjust color temperature
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Adjust the color temperature by dragging the Color Temperature slider in the Look panel.

 

If the image is too warm, lower the color temperature by dragging the Color Temperature slider to the left.

If the image is too cool, increase the color temperature by dragging the Color Temperature slider tool to the right.

 
Low temperature

 
High temperature
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Balance blacks and whites

Note:

To the top

Set black balance
Set black level
Set white balance
Set white level

Balancing blacks is the first step in the color correction workflow. Use the Offset color wheel in the Look panel to balance blacks.

Once the blacks look good, move on to balancing the whites. Use the Gain color wheel in the Look panel to balance whites.

You can use RGB sliders instead of the color wheels. Click the Sliders mode button on the upper-left of the coloring tools.

Use the RGB Parade scope to guide your adjustments. To display the RGB Parade scope, open the Analysis Tools panel by pressing the A key.
For more information, see RGB Parade.

In SpeedGrade CS6, the RGB waveform was available from the Waveform panel. To display the Waveform panel in the Monitor view, press the
W key.  

Set black balance

In the Look panel, drag the hue control tool in the center of the Offset color wheel to normalize color levels in shadows.

Offset color wheel
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To move the hue control tool, do the following:

1. Right-click inside the wheel and release the click button.
2. Swipe the mouse in any direction to change the value.
3. Right-click again to accept the setting

Example

If the image is tinted yellow in the shadows, push the Offset hue control tool toward blue to balance the black values. The adjustment results in
the following waveform change.

Before adjusting black balance

After adjusting black balance

Set black level

In the Look panel, drag the triangle icon on the Offset control wheel until the valleys of the waveform rest on the 0 level of the waveform display.
Drag clockwise to raise the valleys or counter-clockwise to lower the valleys.

Offset color wheel

To move the triangle icon on the color wheel, drag it left or right in a straight line. Don't drag in a circle. The further left or right you drag, the larger
the change.

Moving the valleys below the 0 level eliminates details in the shadows.

Example
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After lowering black value

Set white balance

In the Look panel, drag the hue control tool in the center of the Gain color wheel to normalize color levels in shadows.

Gain color wheel

To move the hue control tool, do the following:

1. Right-click inside the wheel and release the click button.
2. Swipe the mouse in any direction to change the value.
3. Right-click again to accept the setting.

Use the RGB waveform as a guide to adjust highlight color values. In the following example, the blue waveform is lower than the red and green
ones.

Before adjusting white balance

Pushing the gain hue control tool toward cyan and blue balances out the shadows.

After adjusting white balance

Set white level
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In the Look panel, drag the triangle icon on the Gain control wheel until the peaks of the waveform touch the 100 level of the RGB waveform
display. Drag clockwise to lift the peaks or counter-clockwise to lower the peaks.

Gain color wheel

To move the triangle icon on the color wheel, drag it left or right in a straight line. Don't drag in a circle. The further left or right you drag, the larger
the change.

Moving the waveform above the 100 level blows out the whites and eliminates details in the highlights. Example:

After raising white value
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Adjust gamma

Gamma is the relative bright and dark value of the image.

Adjust the gamma setting by dragging the triangle icon on the Gamma color wheel in the Look panel. Drag clockwise to lower the gamma setting
or counter-clockwise to increase it.

 
Gamma color wheel

To move the triangle icon on the color wheel, drag it left or right in a straight line. Don't drag in a circle. The further left or right you drag, the
larger the change.

Use the RGB waveform to guide your adjustments. To display the Waveform panel in the Monitor view, press the W key. For more information,
see Waveform panel.

If the image appears milky, flat or lacks punch, increase the gamma setting by dragging the triangle icon counter-clockwise.

If the image has punch but lacks shadow detail, lower the gamma setting by dragging the triangle icon clockwise.

 
Low gamma

 
Normal gamma
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High gamma
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Grade a specific tonal range
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You can make color corrections to a specific tonal range, such as the highlights, shadows, or midtones.

1. Select Shadows, Midtones, or Highlights on the upper part of the Look panel.

2. Make color corrections using the color wheels and sliders.

3. Extend or limit the affected tonal range using the slider on the right side of the color wheels.

For example, if grading in the shadows, pushing the slider up extends the changes into the midtone region of the image. Pushing the slider
down limits the changes deeper into the shadows.

Tonal range slider
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Apply filters and effects
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Note:

Use filters and effects to quickly apply advanced grading styles to clips.

1. Load a clip on the Timeline.

2. In the Layers panel on the Look tab, click the + icon and then select an effect or filter from the menu.

The + icon is on the lower part of the Layers panel.

3. Modify the effect or filter with the grading tools in the Look panel.

The tools available vary depending on the effect or filter you selected.

4. Adjust the strength of the effect or filter with the opacity slider on the upper side of the Layers panel.
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Work with masks
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Note:

Apply a mask
Apply additional masks

Apply a mask

A mask isolates a region of an image so that you can selectively grade the region. In SpeedGrade, a mask is attached to a grading clip.

1. Add a grading clip to a video clip in the video track. See Create a grading clip.

2. Click the Mask tab and select one of the mask presets.

 

For a feathered mask, select the Vignette Mask.

The Mask widget appears in the Monitor window.

 

3. Do any of the following to adjust the location, size, and shape of the mask:

To reposition the center of the mask, drag the center cross-hair.
To expand the horizontal size of the mask, drag the horizontal-arrow control to the right or left.
To expand the vertical size of the mask, drag the vertical-arrow control up or down.
To rotate the mask, drag the rotational control curve up or down.
To expand the feather size of the Vignette mask, drag the outer edge feather rectangle control on the lower-left corner of the widget.
To adjust the angle of the mask, drag the bottom skew control triangle.

4. Specify the region to grade by clicking the Look tab and select one of the following options in the Layers panel on the left:

Apply Grading Layer to the Outside of a Mask (second icon)
Apply Grading Layer to the Inside of a Mask (third icon)

 

The first icon -- do not apply the grading to a mask -- is selected by default. The last three icons on the right specify whether to
apply a grading layer to the alpha or inverted alpha channel (neither by default).
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5. Grade the region defined by the mask.

For example, drag the Gamma Level control on the outside of the Gamma Control wheel to darken the outside of a mask.

Apply additional masks

You can apply additional masks by adding more grading clips to a video track.

1. Add another grading clip to a video track by dragging the Grading Clip icon to the track. See Create a grading clip.

Assign names to the grading clips to organize mask assignments. Double-click the string “untitled grading” of each grading clip and
specify a name. Example: “Vignette Mask.”

2. In the Mask tab, select the new grading clip and then apply a mask and adjust it. See Apply a mask.

For example, add a circle mask preset and adjust it over a subject's face.

3. In the Look tab, specify whether you want to grade the region inside or outside the mask.

4. Grade the region.

For example, drag the Gain control outer-wheel clockwise to brighten the subject’s face.

5. If desired, apply additional masks by adding grading clips.
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Adjust the framing of shots with pan and scan

To the top

Create a pan and scan track
Change pan-and-scan adjustments along a clip
Pan and scan preview options

Use pan and scan to adjust the framing of your shots for different output formats. You can reposition, scale, rotate, and skew your image to fit best
into other frame format.

Use keyframing to make adjustments within a shot or from shot to shot. For more information, see Work with keyframes.

Create a pan and scan track

1. Drag the Pan & Scan button on the timeline to create a pan and scan track. The Pan & Scan button is on the Timeline panel, under Timeline
Elements.

 

A green Pan & Scan track appears on the Timeline.

 

2. Click the pan and scan track to open the Pan and Scan panel.

3. Select the output format from the Crop Preset menu.
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You can enter any other format in the Crop text box.

4. Use the Pan and Scan widget to position, scale, rotate, or skew the image within the new frame format. The widget works like the Mask
Widget. See Apply a Mask to learn more about using the widget.

Note: The Pan and Scan widget does not have all the functionality of the Mask widget. For example, the feathering and spline nodes are not
available.

You can also apply Pan and Scan adjustment numerically in the Pan & Scan panel. Click the R button to reset to default.

Change pan-and-scan adjustments along a clip

The pan and scan track is a global track along the entire timeline. Any pan-and-scan adjustments affect the whole clip. Use keyframes to change
the adjustments along the clip. For details on using keyframes, see Work with keyframes.

The typical workflow for making pan-and-scan adjustments along a clip consists of the following steps.

1. Create a keyframe at the beginning of the clip.

2. Create another keyframe at any position further along the timeline where the settings should no longer be effective.

3. Create a dissolve from one keyframe to the next by pushing the Record Keyframe button a second time at the second position.

4. Adjust the pan-and-scan settings at the two keyframe positions.
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Pan and scan preview options

You can choose from three different preview options from the Crop Preview menu: Normal (crop), Transparent, and Outline. Select the view that
best serves your project.

 
Normal (crop) preview

 
Transparent preview

 
Outline preview
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Grade a specific color range
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Select and grade a color range
Example: Isolating skin tones with secondaries

Secondary color corrections are applied to specific color ranges within your images. They let you accent, modify, or tone down parts of an
image.

For a video, see Secondary Color Correction by Patrick Palmer.

Select and grade a color range

1. In the Look panel, click the +S icon to add a secondary grading layer.

2. Select a color range to target. Do one of the following to select a range:

a. Choose a preset color range from the range selector.
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You may have to scroll down the Look panel to see the range selector.

If none of the six standard colors is a good starting point, click the gray
button on the right side of the selectors to see more options.

You can also deselect the Hue, Lightness, or Saturation options. This is useful for targeting a specific luma zone for grading. For
example, turning off Hue and Saturation gives you a clean lightness key.

b. Sample a color range in the image. Click the sample range button (the eyedropper icon with the plus sign), hold down the left mouse
button, and move over the color range you’d like to sample. Release the mouse button when you're done.

3. Use the Grey-out options in the right corner of the Look panel to view the selected region of the image.

4. Expand or restrict the target color range by dragging the Hue, Lightness, and Saturation sliders.

The top sliders moves the entire selected range. The bottom sliders feather the selection.

5. Color correct the target range using the grading tools such as the contrast slider or the Offset color wheel.

Example: Isolating skin tones with secondaries

1. Add a secondary grading layer by clicking the +S button in the Look panel.

2. Sample skin tones by clicking the sample range button (the eyedropper icon with the plus sign), holding down the left mouse button, and
dragging a rectangle across a range of skin in the image.

The range selector sliders display the sampled color values:
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3. View the selected region of the image by selecting the Color/Gray option in the Gray-out menu.

4. Adjust the range selection by dragging the Hue, Lightness, and Saturation sliders.

For example, you want to work on a narrower range of skin tones.

5. Smooth out skin blemishes and wrinkles by dragging the Blur slider to the right.

6. Warm up skin tones by dragging the Offset hue control toward yellow.
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Direct-Link workflow between Premiere Pro and SpeedGrade
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New in the October 2013 release of Premiere Pro CC (version 7.1) and SpeedGrade CC (version 7.1)

About Direct Link
Edit and grade Premiere Pro sequences with Direct Link
Open Premiere Pro projects directly in SpeedGrade
Limitations in Direct-Link mode

About Direct Link

The Direct-Link workflow is a new and integrated edit-and-grade workflow between Premiere Pro CC and SpeedGrade CC.

In the past, to use SpeedGrade to color grade your footage from Premiere Pro, you rendered and exported your sequences to SpeedGrade either
as DPX still image sequences or edit decision lists (EDLs). After completing color grading in SpeedGrade, you exported the projects as stand-
alone video files back into Premiere Pro for more editing.  

Direct Link offers a fast and efficient alternative to this workflow. Leveraging the power of the Mercury Playback Engine, Direct Link lets you send
or open Premiere Pro projects directly in SpeedGrade. You can color grade Premiere Pro sequences in SpeedGrade and send it back to Premiere
Pro in a few clicks.

To achieve optimal performance when using Direct Link, use an NVIDIA CUDA graphics card with GPU acceleration on Windows. For more
information about Adobe-certified NVIDIA graphics cards, see the Tech specs.

Edit and grade Premiere Pro sequences with Direct Link

The Direct-Link workflow lets you roundtrip Premiere Pro projects between editing and grading without time-consuming or complex tasks like
rendering and conforming.

Premiere Pro-SpeedGrade Direct-Link workflow
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Note:

Step 1: Select Premiere Pro sequence

Select the Premiere Pro sequence that you want to color grade.

Ensure that you have selected the sequence in the Timeline or Project panel.  

Step 2: Send sequence to SpeedGrade using Direct Link

Using Direct Link, you can send a sequence from an open Premiere Pro project directly to SpeedGrade without exporting the project.

To use Direct Link, select File > Direct Link To Adobe SpeedGrade.

Step 3: Choose to open sequence in SpeedGrade

When you select the Direct-Link workflow, Premiere Pro prompts you to save changes to the project in Premiere Pro and open it in SpeedGrade.
Click Yes.

Step 4: Selected sequence opens in SpeedGrade

Premiere Pro closes, and SpeedGrade opens the sequence in its Timeline, which uses the same familiar track layout as Premiere Pro.

In the SpeedGrade Timeline, you can see all the clip edit points, transitions, and layers.

Project Timeline in SpeedGrade

Step 5: Color grade the sequence using grading and mask tools

Within SpeedGrade, you can color grade the sequence using Looks and Masks. The Looks that you apply in SpeedGrade will appear as Lumetri
presets when you reopen the sequence in Premiere Pro.  

If a Lumetri Look has already been applied in Premiere Pro, it's available in the SpeedGrade Timeline, where you can adjust its parameters.
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A. Premiere Pro project sequence B. Premiere Pro sequence color graded in SpeedGrade 

The Direct-Link workflow has been designed to let you focus on the color correction and grading tasks when you are in SpeedGrade. Because of
this focus, only the Color and Look tabs in SpeedGrade are available in the Direct-Link mode. For more details, see Direct-Link workflow
limitations.

Step 6: Send the color graded sequence to Premiere Pro for editing

When you finish color grading your sequence in SpeedGrade, save and reopen the sequence in Premiere Pro for final output or further editing.

Click the Direct Link to Adobe Premiere Pro icon in the upper left of the SpeedGrade user interface.

The color graded sequence opens in Premiere Pro with all color grading fully intact.

Color grading and masks applied in SpeedGrade are visible in Premiere Pro as Lumetri effects. In Premiere Pro, you can turn these Lumetri
effects on or off for each clip and for each adjustment layer individually using the Effects Controls panel.

You continue editing or export your sequence for final output in Premiere Pro.

Open Premiere Pro projects directly in SpeedGrade

You can open native Premiere Pro projects directly in SpeedGrade, apply color grading changes, and reopen the project in Premiere Pro.

The SpeedGrade Welcome screen lets you:

Open a recently accessed Premiere Pro project (.pproj)
Open a Premiere Pro project (.pproj)
Create a new SpeedGrade project (.IRCP)
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When you open a Premiere Pro project, the Sequence Importer dialog opens showing all the sequences contained in the project. Select a
sequence to open.

SpeedGrade cannot open more than one Premiere Pro sequence at the same time.

Within SpeedGrade, you can apply primary and secondary color correction, apply Looks and Masks, and do all the required color grading.

You cannot send SpeedGrade (.IRCP) projects back to Premiere Pro. To use Direct Link you need to start with a Premiere Pro project
(.pproj).

Some important points:

From within SpeedGrade, you can view and adjust Premiere Pro adjustment layers, and also view any transitions applied to the sequence.
All the color grading that you apply in SpeedGrade is available automatically in Premiere Pro. There is no need to export the .look files.

Working with offline media

When you open a Premiere Pro project with missing media files in SpeedGrade, you cannot link and locate the offline media like you would in
Premiere Pro.

To relink the offline media, you must bring the the project back to Premiere Pro.

Working with After Effects Compositions

There are several ways to use After Effects Compositions in your Premiere Pro project:

Replace a clip in Premiere Pro with an After Effects Composition
Link to an After Effects Composition using Adobe Dynamic Link
Import an After Effects Composition (AEP file) into a Premiere Pro project

Irrespective of which method you use, you can open a Premiere Pro sequence containing After Effects Compositions directly in SpeedGrade.
SpeedGrade opens the sequence in Direct-Link mode, from where you can color grade the compositions just as you would color grade any
Premiere Pro sequence.

Limitations in Direct-Link mode

The Direct-Link workflow has been designed such that you focus only on the color correction and grading workflows within SpeedGrade.

Given this focus, there are specific things to consider while using SpeedGrade in the Direct-Link mode:

To use Direct Link, you start with a Premiere Pro project (.pproj). You cannot send SpeedGrade projects (.IRCP) to Premiere Pro in the
Direct-Link mode.
In the Direct-Link mode, you cannot render your Premiere Pro projects within SpeedGrade. You send the projects back to SpeedGrade for
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rendering. So, the Render and Results tabs are unavailable when using Direct Link.
SpeedGrade can open only one Premiere Pro sequence at a time, and not multiple sequences at once. To open a different sequence in the
project, open the Sequence Importer dialog by clicking  in the SpeedGrade Timeline.
You cannot launch the Media Browser to browse through media, so the Media tab is unavailable when using Direct Link.
You cannot add clips to the Premiere Pro sequence within SpeedGrade. You have to bring the project back to Premiere Pro to edit the
sequence.
You cannot adjust audio or use the Pan & Scan functions. So, Stereo 3D, Audio, and Pan And Scan tabs are unavailable when using Direct
Link.
If you apply the Warp Stabilizer effect on a Premiere Pro sequence, ensure that the analysis is complete before sending the sequence to
SpeedGrade using Direct Link. Otherwise, an error message appears.  
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Snapshot View and Snapshot browser
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New in SpeedGrade CC

SpeedGrade provides you a Snapshot view that lets you quickly capture and save still images of clips. You can then use these images as
reference, or compare to other clips using a split screen.

You can also import TGA images from other applications such as Adobe Photoshop to use as a reference for color corrections and grading. For
more information, see Matching a Photoshop grade.

The Snapshot Browser provides an easy way to store and view images that you save. You can later reference and access these images for your
color-grading work.

Using the Snapshot view and Snapshots browser

1. Position the master playhead on the required clip in your footage, and click the Snapshot icon in the Monitor panel. You can also use the
keyboard shortcut Shift+C.

 
Turning on the Snapshot view

2. You can view the snapshot side-by-side on the Monitor view in a splitscreen mode. To turn off the Snapshot View, click the Snapshot icon
again.

 
Viewing the snapshot on the Monitor view

3. The saved snapshot is saved as a TGA file along with a JPG thumbnail preview (160x45 pixel). You can view the saved images using the
Snapshots browser.
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The Snapshots browser provides a collapsible treeview structure with multiple tab support.

 
Snapshots browser

The snapshots are stored in the following default locations on your computer file system:

Windows: /Users/Documents/Adobe/SpeedGrade/7.0/settings/snapshots/
Mac: C:\Users\...\AppData\Roaming\Adobe\SpeedGrade\7.0\settings\snapshots

You can access the snapshots from these locations to share the images.
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Managing looks

Working with Looks
Patrick Palmer (Jun. 17, 2013)
video-tutorial

Apply Looks with Looks Manager
Adobe TV (Jun. 17, 2013)
video-tutorial
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Share and reuse looks
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Note:
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Save a look
Share a look
Apply a look in SpeedGrade
Apply a look in After Effects
Apply a look in Photoshop
Save a look for Premiere Pro and third-party applications
Delete .Look files
Use the Look Management Browser

SpeedGrade can save color grading information in .Look files for reuse. Because the files are small, you can easily store them or share them with
others.

Save a look

1. Grade some material.

2. In the Look tab, click the Save Look button on the lower right side of the Layers panel.

 

You can also press Ctrl+P (Windows) or Cmd+P (Macintosh) to save the Look file.

The .Look file appears in the Look browser as a thumbnail. The default location for the files is ../SpeedGrade/settings/looks.

 

If you get an error that the folder is read-only, close SpeedGrade and then run it as administrator. In Windows, right-click the start
icon and select Run as Administrator.

3. If desired, rename the .Look file by clicking the current name and typing a new name.

Share a look
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1. Locate the .Look file to share. The default location of .Look files is ../SpeedGrade/settings/looks.
2. Send the file as an email attachment or move or copy it to a shared folder in the Cloud or on a network.

Apply a look in SpeedGrade

1. Select a clip or grading track.
2. In the Look browser, navigate to the folder containing the .Look file you want to use. Use the left and right arrow keys to navigate to more

folders.
3. Select a .Look file and press Enter to apply it.

You can also drag the .Look file on the Timeline. It appears as a grading clip that you can resize and reposition to apply the look across
multiple clips, scenes, or a whole project.

Apply a look in After Effects

Adobe After Effects supports native .Look files.

1. With footage open in After Effects, select Effect > Utility > Apply Color LUT.
2. Select the .Look file from your hard disk.

To blend the look in After Effects, create an adjustment layer above the clip in the Timeline, then apply the look (Effect > Utility > Apply Color
LUT). In the Timeline, select the adjustment layer, then press the T key to bring up the transparency control. Adjust the transparency to blend
the look.

Apply a look in Photoshop

Adobe Photoshop supports native .Look files.

1. With an image open in Photoshop, select Image > Adjustments > Color Lookup.
2. In the Color Lookup dialog box, select the Load 3D LUT option.
3. Select the .Look file from your hard disk and click OK.

For more control over the look, create a Color Look Up adjustment layer. Select Layer > New Adjustment Layer > Color Lookup, and then
select the .look file from the contextual menu.

Save a look for Premiere Pro and third-party applications

You can export a .Look file with one or more LUT files to use in Adobe Premiere Pro or a third-party application.

LUTs do not include masks or effects such as blur or glow.

1. In the Look browser, mouse over the .Look file. An export icon (E) appears on the right of the thumbnail.
2. Click the export icon, select additional files to include, and click Export.

SpeedGrade creates a zip file containing the files.

A LUT is not required if you're sharing a look with After Effects or Photoshop, which support native .Look files. See Share looks.

109



  Twitter™ and Facebook posts are not covered under the terms of Creative Commons.

Legal Notices   |   Online Privacy Policy

To the top

Delete .Look files

1. In the Look browser, mouse over the .Look file. A delete icon (X) appears on the right of the thumbnail.
2. Click the delete icon and then confirm the deletion.

Use the Look Management Browser

The Look Management Browser lets you effectively organize, view, or minimize the Look presets that you save.

You can choose from the following three different views to display Look presets:

Look Management View Mode 
Quick View Mode 
Minimized Browser View 

For more information, see Look Management Browser.
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Rendering out

Rendering out your project
Patrick Palmer (Jun. 17, 2013)
video-tutorial

Creating dailies
Patrick Palmer (Jun. 17, 2013)
video-tutorial
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Create proxy files for offline editing

For a faster workflow, you can work on low-bitrate proxy files (“proxies”) rendered from high-bitrate master files. This article describes how to
create proxy files for offline editing while preserving both the original file naming and source time code.

1. Move all the source clips to the Timeline as follows:

a. Browse to the source folder in the SpeedGrade Desktop.
b. Click the Add All button on the lower-right side of the Desktop.

2. Define the output folder for the rendered proxy files as follows:

a. Select the Output tab.
b. Specify an output path in the Folder field with the breadcrumb control.

 

3. Instead of typing a file name for the proxy files, specify the following file naming option:  

a. In the File Name field, click the M icon for lists of preset metadata tags.
b. Select the “Src.PathElement.0” option.

 

This option splits the Timeline into individual QuickTime files for rendering. It also matches the output file name to the source file name.

4. Set the Time Code Source to the Source option to preserve the master file time code information.

 

You can also set the time code source to other time code generators based on the workflow.

5. Select the output format, calibration lookup table (LUT), and framing settings as with any regular render job.

6. Select Online Quality or Offline Quality and then click Render.
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You can export an Edit Decision List (EDL) of assembled clips from the Timeline.

1. With two or more clips on the Timeline, click the Setup button on the Timeline panel.

 

2. In the Tools panel on the right side of the panel, click Save EDL.

 

3. Name the EDL, select a folder, and click Save.
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Display burn-in information during playback
Display burn-in information on the rendered output

You can "burn" (overlay) metadata information on your frames during playback or on the rendered output. For example, selecting the Standard
burn-in preset in SpeedGrade superimposes the following information on the footage:

Current frame number
Location on disk of current sequence
Native time code of current frame (assuming the information exists in the header of the file format you’re using)

Display burn-in information during playback

1. In the Timeline tab, select the View pane.

2. Under Display Options, select a burn-in preset from the Burn In menu.

If the menu is inactive, click the Burn-in tool to make it active.

 

Display burn-in information on the rendered output

Including burn-in information on rendered output can be useful when creating proxy media for offline editing or dailies for review.

When setting the rendering options in the Output panel, select a burn-in preset from the menu.
In the Flash Burn-In For text box, set the number of frames to display the burn-in information. The default setting is 0, meaning burn-in
information is included on all rendered frames.
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